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Oops!  and Legal  Stuf f  

 

While I have made every effort to ensure the accuracy of this document, including grammar and 

instructions, I make mistakes. (Surprise!)  If you find an error or want to provide constructive 

feedback, please contact me.  Thank you!  Enjoy Excelling at Excel and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

V National Speakers Association Member 

V American Society of Training and Development Member 

V Society for Human Resource Management 

V Microsoft Office User Specialist Certification ï Master Expert 

V A+ Certified through CompTIA 

V Microsoft Certified Technical Trainer 

 

Excel ® is a most excellent product from Microsoft ® Corporation and is part of the Office ® 

Suite of products and services.  

 

Copyright © 2011 Greg Creech, Techedutainment Services, Inc.  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any 

means, electronic or mechanical, including photocopying, recording, storage in an information 

retrieval system, or otherwise, without express written permission of Greg Creech, P. O. Box 

1431, Pine Lake, GA  30072-1431, www.gregcreech.com. 

http://www.gregcreech.com/
http://www.gregcreech.com/
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Greg Creech 
sings to his 
students, and 
often he 
performs stand-
up comedy 
about 
computers. 

In t roduc ing Greg Creech  

Shop Talk from The Atlanta Journal-Constitution 
Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job ï Greg Creech 
What I Do: I teach technology courses and make presentations to beginner and expert computer 

users and professionals.  I use humor and the piano.  

I train all levels from first-time computer users to 

systems technicians acquiring A+ certification.  As 

an A+ certified trainer, MOUS expert, and technical 

trainer, my certifications and knowledge give me a 

career in the technology.  My humor, the piano, and 

people keep me in the technology training field. I 

sing to my students sometimes and perform stand-up 

comedy about computers. 

How I got started:  I won Best Actor in a 

Supporting Role at Southside Theatre Guild for ñA 

Funny Thing Happened on the Way to the Forumò 

and studied comedy under Jerry Farber.  I have 

played the piano since 8 years of age and had the 

first personal computer with a 1 MB of memory.  In 

order to learn the PC, I associated the PC with the 

piano  -- both use a language to translate, both have 

keyboards, and now - both provide music and 

information.  I must admit I miss the days when I 

only played the piano and programmed the PC.  

Now, I play the PC and have to program my piano.  

In 1998 after seventeen years of technology business experience in the corporate market, I decided to take a 

leap of faith on my own. I call my presentations ñShowminars,ò a combination of a 

show and a seminar. 

The Best Part:  Hearing the laughter and the comments:  ñYou have saved me so 

much time,ò and ñI remember complicated macros because of the way you taught 

them.ò I have a passion for teaching creative people to be more technical and 

technical people to be more creative ï Mozart would be proud! 

The Challenging Part:  Explaining why I want my piano in a PC classroom.  

ñMainframersò who refuse to acknowledge the existence of the PC and the Web.  

People who attend training classes because they have to, not because they want to.  

Technical people who are not client- focused. 

My Favorite Quotes:  ñTo err is human, to really mess things up you need a computer.ò  ñForty-two 

percent of all households have a computer; only eight percent of those know how to use it.ò  

What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a 

unique speaking and learning experience. 

Technology 

speaker and 

trainer 

Speakin' & 

Geekin' 

Pine Lake 
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Welcome to  Excel l ing a t  Excel  
 

Welcome to your course that will lead to ñExcellenceò at Excel.  I have used spreadsheets and 

predecessors to Excel since 1980.  I have used Excel from the inception of the program.  As an 

Operations Manager, Sales Support person, and Administrative Manager I have used and abused 

Excel, and Excel has used and abused me.  Properly using Excel can be tricky and troublesome, 

but once you master the navigation in Excel and the powerful formula and functions your 

professional and personal life of number crunching will be much easier and more productive. 

First, we will examine how to maneuver in Excel and some of the important efficiencies in Excel 

viewing an existing spreadsheet.  Weôll examine the new user interface in Excel 2007/2010 and 

the Ribbon as well as new features and productivity in the new version. We will learn many 

shortcuts throughout the course. 

Second, we will learn the 5 ï Fs of Excel as we construct our own Monthly and Annual Budget 

and Expenses worksheets.  The 5 Fs are: 

V Formatting, 

V Fills , 

V Formulas, 

V Functions, 

V Filters and Sorts. 

Third, we will use Excel as a tracking system and simple database using the PMT function; 

weôll create our own financial database. 

Fourth, we will learn some of Excels Analytical Tools such as 

V Scenario Manger 

V Charts, 

V Pivot Tables, 

V Subtotals, 

V Group and Outline, 

V Data Validation 

We will learn and use some of Excelôs great functions such as VLOOKUP, CONCATENATE, 

IF. . . THEN, and others.  
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Finally, we will study Worksheet Protection and Macros. 

 

The purpose of this course it not only to teach you but to increase your productivity because as 

we learn we will be building your personal or professional budgeting system using your data.  I 

will provide guidance in class and in the document to assist you; however, the data is yours and 

your application will save you time and energy. 

 

Again, Welcome.  Letôs have fun and learn (flurn) together. Letôs begin Excelling at Excel. 
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Welcome!  To  Excel  2010  

Letôs look at Excelôs main window and components of the new interface. 

1.  Open Excel.  

2.  Excel will present a blank Worksheet ready for you to begin  or Excel 

may provide a screen for  you to use templates or open other files .  As 

below  for you.  In any event, create a new blank workbook.  

3.  Pictured below is the Worksheet Window for Excel 2010 . 

4.  Letôs take a tour of your Worksheet Window. 
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1. The File Tab, Quick Access 

Toolbar and Title Bar. 
2. The Ribbon with 

Tabs, Groups, and 

Commands. 3. Name Box and Formula 

Bar. 

4. Worksheet area with Column 

Headers (the Alphabet) and 

Row Headers (the Numbers). 

The intersection of columns and 

rows create cells and the Excel 

grid. 

5. Navigation buttons and 

Worksheet tabs. 

6. Status Bar, View Buttons, and 

Scrolling Zoom. 

Worksheet  Window 

The top area of your screen is the Quick Access Toolbar with the Title Bar. The File Tab which 

is the first tab in the Office 2010 Ribbon allows you to print, save, and perform other file  

  

functions; weôll learn much more about this including using the Excel Options button. Next in 

this area of your worksheet is the Quick Access Toolbar which allows you to quickly access 

your favorite commands and you may add and delete commands from this toolbar.  Weôll learn 

how to customize the toolbar and other options for using this productive tool in Excel.  The Title 

Bar displays your Excel File or Workbook Name and contains the Minimize, Restore/Maximize, 

and Close commands. 

  

Workspace 
Area  
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Groups 

Tabs 

Command 

Buttons/Icons  

  

 

 

The next area as pictured above is The Ribbon. The Ribbon contains three areas ï The Tabs, 

The Commands, and The Groups with the Dialogue Box launcher. We will use the Ribbon 

extensively in all aspects of Excel from formatting to creating formulas and functions.   

1.  Letôs open a sample workbook  to use in our demonstration.  

2.  Click the File Ta b.  

3.  From the Cascading Menu, Click Open.   

4.  Navigate to where your files are stored for this course.  

5.  With the Budget.xls x file selected, Click Open OR Double Click 

the Budget.xls x icon to open the file in Excel.  

6.  If  you are prompted to Enable Macros, please cl ick Enable Macros.  

Our workbook opens.  We should have two workbooks open a blank workbook and the 

Budget.xlsx workbook. 

 If you donôt have two workbooks open then follow these steps.  

1.  Click the File Tab  and Click New.  

2.  From the New Workbook screen click the Blank Workbook item and 

then click the Create button at the lower right of your screen.    

We can ñtoggleò or move between the two files using our View Tab on the Ribbon and Clicking 

the Switch Windows command button. Letôs try this.  

1.  Click the View Ta b and click the Switch Window,  

2.  Click the File that is not active, for example my Book2 as 

displayed here and file activates.  

3.  If your View tab is still active (or if not then click it to activate 

it again), and then c lick your Budget workbook to activate it . 
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Below the Ribbon and Groups are the Name Box and 

Formula Bar. The Name box indicates your position and 

selected cell in the worksheet and allows you to give 

selected cells an English name or code which we learn later in our course.  This allows you to 

quickly move to this area of your worksheet and to calculate formulas using names.  

 

The Formula Bar illustrates the contents of your cell whether numeric or alpha text.  You edit 

your functions and formulas in this box.  Formula and functions begin with an equal sign (=), 

weôll learn a lot more about this in the Formula and Functions part of our course. 

Select  A l l  Bu t ton  

,A Hot Tip!   

Select All Button:  There is a magic box in the upper left part of your worksheet 

(bounded by the Column header A and Row header 1).  This magic box selects the entire 

worksheet with one click of this button; this is the Select All Button. If you are not clicked in 

the table of data, you may select the entire worksheet by pressing the CTRL + A keys together; 

if your cursor and selection is in the table of budget and expense figures CTRL + A keys 

selects the data table not the worksheet. 

Column Headers are the Alpha characters beginning the column.  You may click on a Column 

Header and the entire column selects or highlights.  You may click on a column header and drag 

to the desired column to select multiple continuous columns.  You may select columns that are 

not continuous by left clicking, pressing the CTRL keyboard button, and then left clicking the 

desired columns; when complete release you CTRL key and mouse button and Viola your 

columns are selected.  You may use this method to select various cells and rows, as well, that are 

NOT continuous.  
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, A Hot Tip!  In this document when we want to select cells 

and areas that are not contiguous I will use the term Ctrl + 

Click to indicate using the Ctrl key and click method of 

selection.  When we want to s elect areas that are contiguous 

I will use the term Shift + Click or we may also use Click and 

Drag to select continuous areas of our worksheets.  ,  

 

Row Headers are the Numeric characters or numbers at the beginning of the row and operate in 

the same fashion as Column Headers. 

A Cell is the intersection of a column and row.  Cells are signified by the column letter and row 

number position, such as Cell C4 is the intersection of Column C and Row 4 or G10 is column 

G, Row 10 (BINGO! Ha, ha!)  You may select multiple cells by left clicking on a cell and 

dragging to the area that you desire and release your left click button. 

Letôs practice selecting continuous and non-continuous columns and hiding and unhiding 

them. 

1.  With your Budget Workbook open and 

your January tab active, click column 

header C.  

2.  Press your Shift Key and Click the 

column header G. Columns C through G 

highlight for you.  

, A Hot Tip: You may get the small dark arrow to select your 

column header and click and drag to select your continuous 

columns, too. ,  

3.  With these columns selected, right click on one of the 

letters and from  the shortcut menu click  Hide and the 

columns di sappear.  
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Letôs unhide them and the hide columns that are not continuous. 

4.  Click the Select All button at the top of your workspace 

area to select the entire workbook.  

5.  Right click on a column header and from the menu 

click unhide.  

6.  Now, Click column header  C and press the CTRL (or Control) Key and 

keep it pressed as you click other columns.  

7.  With your CTRL key pressed, click column header F and column header 

H.  These columns select for you as you click them with the CTRL key 

pressed.  

8.  Now, right click one of  your selected column headers and from the 

short cut menu choose hide.  

9.  These non -continuous columns hide for you . 

10.  Letôs unhide them. Click the Select All button at the top of your 

workspace area to select the entire workbook . Right click on a column 

header s and from the menu click unhide.  

Notes:  

 Ï If you want to unhide a specific column but keep the others hidden 

for example if I want to unhide Column C but keep the other columns 

hidden, I can select Columns B through D with Column C hidden and 

right clic k on the two selected column headers and from the shortcut 

menu choose unhide and onl y Column C is unhidden.  

Ï If you click inside of the Budget and Expenses and press CTRL + A 

only the table of data selects not the entire worksheet.  You may use the 

Selec t All button to select the entire worksheet or CTRL + A to only select a 

table or database in Excel.  

Worksheet area is the area surrounded by the column and row headers and is your primary work 

space in a worksheet. 

Worksheet Navigation Buttons and Worksheet Tabs: The Navigation Buttons at the lower left 

of your workspace area scroll to various worksheets within your workbook in order for you to 

select the worksheet in which you desire to work.  A description from left to right by clicking the 

appropriate button is:  
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Button 1: Scrolls to the first worksheet,  

Button 2: Scrolls to left one sheet,  

Button 3: Scrolls to the right one sheet,  

Button 4: Scrolls to the final worksheet.  

 

,A Hot Tip!  If you have multiple worksheets as the  Budget 

file  does, you can quickly go to a specific sheet by  right clicking 
on the navigation buttons to get a shortcut menu and then left 
clicking the sheet you desire.  In the picture at right my Annual  
sheet is active and all of the she ets are displayed.  If I wanted 
to go to the October sheet, I could click it and that sheet would 
activate.  Worksheet tabs names your worksheet and become 
active upon clicking on the tab.   If you have a lot of worksheets 
Excel displays ñMore Sheets. . . ñ at the bottom of this dialogue 
box for you to open another box allowing you to vertically scroll 
through and activate your desired worksheet.  

 

The Status Bar displays information about your worksheet and cells, displays whether your 

Number Lock and Caps Locks are activated, whether you are recording a macro, and has a nifty 

Calculation box that we will use later. 

You can navigate in your worksheets and through your worksheets through several keyboard 

shortcuts, too, and select data in a column or row quickly.   
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Keyboard Shortcut  What it Does  

CTRL + Home  Takes you to the top of your worksheet, 

usually cell A1. 

CTRL + End  Take you to the end of your worksheet.  

PgUp and PgD n Takes you down or up several rows 

(screen pages) at each press of the key. 

CTRL + PgUp and CTRL+PgDn  Scrolls through your worksheets or tabs.  

CTRL+PgUp Scrolls to the Left for you and 

CTRL+PgDn scrolls to the Right. 

CTRL + Shift + Down /Up  Arrow  Selects an entire column of 

data/information  based on the cell that is 

selected. 

CTL + Shift + Left /Right  Arrow  Selects an entire row of data/information  

based on the cell that is selected. 

 

With your Budget file open, use these navigation techniques to na vigate 

around your worksheets and open the Track workbook and select a column 

and row data using the CTRL + Shift and arrow keys.  

 

Ï Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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Impor tan t  T ips  to  make your  Exce l  

Exper ience Eas ie r 

Resizing columns and rows 

If you position your cursor between a column and row header, a double-headed arrow will 

appear as your cursor.  Click and drag to resize your column or row.  You should place your 

cursor to the right of the column you want expanded and below the row you want increased.  For 

example, to change the width of column C move your cursor between column headers C and D 

to get the double headed arrow to resize your width.  To change the height of row 7 you would 

move your cursor between row 7 and 8 to get the double headed arrow to 

change the height of row 7.  You may right click on a column or row header 

and from the Shortcut menu choose Column Width or Row Height and the 

screen at right appears for you to type in a number for the width/height of 

your column/row. 

, A Hot Tip! If you double click your double headed 

arrow cursor, the row or column will automatically adjust to 

fit the information in the column or row.  Pound symbols  or 

hash marks  (##### ##) will appear in cells that are not 

large enough for you to view the data.  The pound symbols  or 

hash marks  in a cell have ñfreaked outò many a new user to 

Excel, including me.  I felt like I had done something terribly 

wrong.  Simply resize your  column width so the data in the 

column will fit.  , 

Rename a Worksheet 

To rename a worksheet, double click the worksheet tab at the bottom of the screen.  For 

example, to rename Sheet 1 double click the Sheet 1 tab, the tab is highlighted, and type a new 

name and press enter.  Also, you may right click on the Sheet Tab for a short cut menu to 

Rename the worksheet.  As well as Renaming your worksheet, Right clicking on the tab allows 

you to insert, delete, or move/copy your worksheet.  This is a great tool and short cut that we 

will be using throughout this course.  
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Ï Notes: Worksheet names should not contain special characters, such as /, 

?, or [] and you may not use the same name twice in a workbook.  You are 

limited to 31 characters  for a name.   

 

,A Ho t  T ip !  Status Bar and Calculations 

The Status Bar in Excel 2010 has many options from which to choose.  

I like having the Sum, Count, Average, and other functions on my 

Status bar.  You may right click on your status bar and receive the 

Customize Status Bar Pane as pictured at right.  I have activated all of 

my options as I learn Excel 2010. 

This doesnôt affect your worksheet, but does provide the result of the 

functions based upon your selected range of cells.  This is another 

excellent and quick tool for summarizing, averaging, etc. cells and 

information that are continuous or not.  Letôs try it out 

1.  In the January Tab of your Budget  worksheet, 

Click and Drag cells B5 through B10  to sele ct 

them . 

2.  The Sum , Average, Count and other functions  of 

the cells should appear  based on your selection in the Customize 

Status Bar pane .  

,A Hot Tip!   Another neat trick is to use the CTRL + Click method to select 

cells that are not continuous, such as B 5, B7, B9, the Calculation s will provide 
the SUM ( or other selected function) for the cells selecte d. This provides 
quick calculations for cells that are not continuous and prevents you from 

creating a formula or pulling out the good -old calculator.  , 

1.  Letôs select non-contiguous cells and see the resul t s. 

2.  Click Cell B5 . 
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3.  Press your CTRL key and keep it pressed as you click the following 

cells:   C7, C8, C10, C11, and B16.  

4.  Notice that as you click your cells your calculation s change.   

5.  You can click away f rom the area to deselect your changes.  

L An Important Gotcha! If you accidentally click the wrong cell or do not want a 

previously selected cell in the calculation, you cannot CTRL + Click the cell again to 

deselect it as you can in other applications and areas of Excel.  Youôll have to start from the 

beginning of selecting your cells using the CTRL + Click method again. L  

 

There are important items at the end 

of your Status bar.  The View 

command buttons for Normal, Page Layout, and Page Break Preview are here for you and the 

Scrolling Zoom. 

Weôll look at these views later. 

Click the Zoom selector arrow and click and drag in out to see how Excel 

changes  your view of your worksheet.  

 

Go To and Scroll ing Bars 

Use your vertical and horizontal scroll bars to quickly move through 

your worksheet area.  You may move to a Specific Cell by pressing 

your CTRL key and G key at the same time or pressing the F5 key on  

your keyboard and the Go To dialogue box appears.  Type the Cell you 

wish to go to in the reference section. 

Letôs practice this. 

1.  Press CTRL a nd the G key simultaneously  OR 

press the F5 B utton on your key board.  

2.  Typ e B20 in the reference section,  

3.  Click OK or press Enter.  

4.  You are quickly in Cell B20.   

 

Vertical and 
Horizontal 
Scrolling 

Bars  



Greg Creech 2010 Excell ing at Excel  Page 21  

www.gregcreech.com 

Greg Creech © 2011 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

A Little Review Here: Shift Clicking and CTRL Clicking:  As explained in the Column Header 

section, if you desire to select continuous rows, columns, cells, and even worksheets click on an 

item, press shift, and click the last (Shift + Click) item you desire to be selected.  (The columns, 

cells, or rows are selected continuously.)  If you desire to select items that are not continuous, 

use the CTRL key to click your desired row headers, cells, column headers (etc.) and your item 

will be selected until you release the CTRL key and cease clicking (Ctrl + Click). 

 

Note the ScreenTip as you position your cursor over a command button or area of your 

worksheet.  This is very helpful to understand the purpose of the command button or area. 

 

Another handy key on your keyboard is the Esc (or the Escape) key.  Ï When doubt, press this 

a couple of times to clear your formula, selected cells, and other times when you feel you are 

making a mess or Excel wonôt let you move or navigate because you have not completed a 

function..  The Escape key will help alleviate trouble, but may not prevent bad formulas and 

formatting.  Ï 

Ï Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Customiz ing Excel  fo r  Product iv i ty  
 

Quick  Access  Too lba r Op t ions and  

Cus tomiza t ion   

As we begin using Excel, we need to learn the Quick Access Toolbar and how to add command 

buttons to it.  Weôll examine the Ribbon and other new interface techniques as well as using old 

(even ancient) keyboard commands that have been around since DOS and new keyboard 

commands called Key Tips that are new to Office 2007/2010. Adding your own command 

buttons to the Quick Access Toolbar ensures the command button is always available for you 

since your command buttons change based on which Tab you have active.  

New for Office 2010 is the ability to customize the Ribbon and create your tab as well as to 

enable and disable tabs.  We will accomplish this in your next section. 

 

L Important Gotcha! When your Excel Options menu is open and active nothing in Excel 

is operable and all tabs and groups are disabled.  L 

 

Letôs look at the Customize Options for our Quick Access Toolbar.  

1.  The Quick Access Toolbar is the only toolbar in 

Office 20 10  and is located at the top area of your 

screen in the Title Bar area.  

2.  In a blank Worksheet or the Budget workbook, 

click the Arrow at the end of your Quick Access 

Toolbar to list the Customize Quick Access Toolbar 

command buttons and options.  

3.  You may quickly add command buttons to your 

toolbar by clicking them in this window to add 

them to your toolbar ï the check mark represents a command button 

already on your toolbar.  

4.  The cascading menu closes after you c heck an item to add, such as 

New, Open. I wish the menu could remain open as you check these 
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command buttons.  Check all of the buttons to add these to your 

Quick Access Toolbar.  

After adding these buttons, we will further customize the Quick Access Toolbar with some of 

my favorite and popular commands in Excel.  We will use the More Commands from your 

Customize Quick Access Toolbar Pane.  

We are using the More Commands button and Excel option screen for three reasons: 

1. You may rearrange and move your buttons as you like, 

2. You may add more than one button at a time, 

3. You may add buttons that do not exist in the Ribbon or Tabs. 

Letôs add rearrange our buttons and add some neat and helpful commands so we may quickly 

use some of Excel best commands. 

 

1.  At the end of  your Quick Access Toolbar click the arrow and then c lick 

the More Commands. . . item in this menu.  

2.  The Excel Options Pane opens at the Customize screen ready for you 

to select commands and add them to your toolbar. First letôs move 

some of the commands we  have already added.  

3.  Click the New command button and using the Up arrow click to move 
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the command button to the top as displayed above. Next move the 

Open and the Open Recent Fileé below the New button. Rearrange 

your buttons to fit your needs.  

Now, let ôs add buttons to our Quick Access Toolbar. You may add buttons 

by selecting the command you want on the left part of the pane and double 

clicking the button or clicking the Add button in the Center of the Pane.   

, Hot Tip! You may add your button to your  Quick Access 

toolbar in the position you want by selecting the Quick Access 

Command, such as Sort Descending and the double clicking 

or clicking the Add button and the Custom Sort button is 

beneath your Sort Ascending and Descending buttons. Excel 

places the new command button below where your selection 

is on the right part of your pane.  , 

1.  I have added some of my favorite command buttons from the Popular 

Commands section.  As you use Excel 2010  you will find command 

buttons that you will want always avail able for you.  Using the Popular 

Commands item in the Choose commands from: box.  Here are some of 

my favorite commands to add to and rearrange on my Quick Access 

Toolbar using the Popular 

commands item:  

V Custom Sort  

V Cut,  

V Copy,  

V Paste  

V Paste Special  

V Insert Sh eet Rows  

V Insert Sheet Columns  

V Set Print Area  

V Freeze Panes  

V Page Setup  

V Paste Special   

V Insert PivotTable  
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Add your popular commands and rearrange them on the Quick Access 

toolbar by selecting a command and using the Up and Down arrows to 

move your buttons.  

 

The Drop Down box (circled below) at the top of the customize screen allows you to choose 

other Tabs or All Commands in order to add other command buttons to your toolbar; this is 

the Choose commands from box.  The second box at the right allows you to use the custom 

Quick Access Toolbar in all workbooks or only the current workbook. We want this for all of 

our workbooks. 

1.  Next change your Choose commands from box to All Commands as 

circled above.  Press the letter 

A and scroll to AutoFilter .  Add 

AutoFilter to your Quick Access 

Toolbar this command button 

doesnôt appear on the Ribbon 

and is very helpful.  This one 

button accomplished two tasks 

ï first it will filter for whatever 

you have selected and it will 

turn on your filtering for you .  I 

also add the Clear Filter button.  

Notice ALL of the Commands in Excel and add your buttons as you 

wish.  

2.  Next, click back in the All Commands list and press the letter C on your 

keyboard. Excel jumps to the C for you to scroll down or continue 

press ing the letter C 

on your keyboard to 

find the Clear 

button. You want 

the Clear button 

with the Funnel or 

Filter.  

3.  Next, decide if you want to show the Quick Access Toolbar above or 

below the Ribbon.  Since I use so many commands on my Quick Access 
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Toolbar wh ich crowds my Title bar, I like having my Quick Access 

Toolbar below the Ribbon so I have checked the box.  

4.  Click OK.  
 

,A Hot Tip !  The Reset button will restore 

your Quick Access T oolbar back to the 

Factory Standard with no customization.   

Pressing the Reset buttons offers you to 

Reset only the Quick Acces Toolbar or All 

Customizations.  The Dialogue box below 

appears  when you click the Reset button .  I sure do not want 

to click yes, since we will use our Quick Access Toolbar 

throughout the course. ,  

 

 There is a quicker and easier way to add buttons to your Quick Access Toolbar and 

hereôs the HOT TIP for you. 

 

, A Hot Tip:  You may add any command button to the Quick 

Access Toolbar by right clicking the command 

button and from the menu cho ose add to Quick 

Access Toolbar.  I have right clicked my Merge 

& Center command button on my Home Tab 

and the menu at right displays for me to click 

the Add to Quick Access Toolbar item and Excel places the 

command button on the toolbar for me.  Using thi s method 

places the button at the end of your toolbar, unfortunately 

you must use the Customize Quick Access Toolbar pane in 
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Excel Options to rearrange the commands position as we 

accomplished earlier. , 

 

Ï Write your notes here:_________________________________________________________ 
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Tabs and  Groups 

As we begin our study of the tabs and groups, here are a couple of important and time saving 

Hot Tips for you in using the Ribbon and Tabs! 

, Hot Tip 1:  Minimize the Ribbon ! Four ways to minimize the Ribbon ï First, the 

Ribbon takes up a lot of space on your screen. You may minimize the Ribbon and 

use it only when you click on a Tab.  

1.  Office 2010 has the new Minimize Ribbon arrow at the top of your 

window next to the Help button.  The Minimize the Ribbon button 

appears at right. With the Ribbon minimized the button becomes the 

Expand the Ribbon button.  

2.  To minimize the ribbon double cl ick the active  Tabôs Name. Double clicking a tab 

expands/minimizes the ribbon, too.  

3.  Right click on any tab or command button on the 

Ribbon and from the short cut menu choose Minimize 

the Ribbon at the bottom of the menu.  

4.  Keyboard shortcut of CTRL + F1 ï w hen you press 

your CTRL (Control) and the F1 keys simultaneously on your keyboard the Office 

application minimizes and expands your Ribbon, too. , 

Why minimize The Ribbon?  The Ribbon takes a lot of space. With the Ribbon minimized you have 

more room in which to work on your file.  With the Ribbon minimized, to use a tab, you click the tab 

and the Ribbonôs tab expands for you to use the Command Buttons.  After clicking the button you 

want and you click back into the body of your document, worksheet, or presentation the Ribbon 

minimizes again. This is similar to using the old Menu bar.  The difference is the Menu bar was 

vertical and text oriented and the Ribbon is horizontal and more graphically oriented.  

, Hot Tip 2: Second, if you have a scroll wheel/butt on on your mouse and 

the Ribbon is NOT minimized, you may scroll through the different tabs 

rather than clicking the tab.  Moving your cursor to the Ribbon and rolling 

your scrolling button/wheel up or down changes the tabs for you! You must 
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first click on  a tab for this to work; otherwise, the application will scroll 

through your file ï not the Ribbon. ,  

L An Important Gotcha! With the Ribbon minimized you cannot scroll through the Tabs as 

described above.  Youõll have to maximize the ribbon in order to scroll through your tabs 

and command items. L 

Try these two shortcuts, I think youôll like using these two features in Office 2010. 

Excelôs interface includes the Ribbon which contains tabs as we have studied and within the tabs 

there are groups such 

as the Clipboard 

group, Font Group, 

and Alignment 

Group as displayed 

at right.  At the bottom of some groups you will notice an arrow, as 

circled above, this arrow is the Dialogue Box Launcher which offers 

more options for you.  Activating a Dialogue box from this group 

opens the Dialogue box tab for that group.  When I clicked the Font 

Dialogue box launcher, the Format Cells Dialogue box opens at the 

Font Tab. 

We will use many of these tabs, groups, panes, and dialogue boxes 

throughout this book.  Weôll start with the Home Tab and Formatting 

options, including the Mini Toolbar, after we look at some of the 

Keyboard shortcuts and Key Tips. 

 

, Hot Tip! You may add a Dialogue box to your 

Quick Access Toolbar by right clicking the 

Dialogue Launcher Arrow and from the menu 

choosing Add  to Quick Access toolbar just as we 

accomplished with the Merge and Center button.  

As displayed here I am adding my Number format cells 

dialogue box to my Quick Access Toolbar. ,  
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Keyboard  Shor tcu ts  and  Key  T ips 

Hereôs a nifty table of my favorite Office, including Excel, shortcut keys. 

My Favorite Keyboard Shortcuts (Office 2007/2010 and others) 

Keyboard 

shortcut 

Command Keyboard 

shortcut 

Command 

CTRL + A Select All CTRL + T Excel Create Table 

CTRL + B Bold CTRL + U Underline 

CTRL + C Copy CTRL + V Paste  

CTRL + D Excel ς Fill Down 

 

CTRL + W Close ς Closes the Workbook in Excel,  

CTRL + E Word and PowerPoint Center 

Alignment ς Paragraph 

Excel ς ¦ƴŀǎǎƛƎƴŜŘ κ5ƻŜǎƴΩǘ ǿƻǊƪ 

CTRL + X Cut 

CTRL  +  F Find CTRL + Y Repeat Last Action 

CTRL  + G Go To CTRL + Z Undo 

CTRL + H Replace ESC This key cancels the current command 

or operation. 

CTRL + I Italic CTRL + Home Top 

CTRL + J Word and PowerPoint Justify 

Alignment ς Paragraph 

Excel- ¦ƴŀǎǎƛƎƴŜŘκ5ƻŜǎƴΩǘ ǿƻǊƪ 

CTRL + End End/Bottom 

CTRL + K Insert Hyperlink F1 Help 

CTRL + L Word and PowerPoint Left Alignment 

ς Paragraph 

Excel-¦ƴŀǎǎƛƎƴŜŘκ5ƻŜǎƴΩǘ ǿƻǊƪ 

F5 Go To 

CTRL + N New F7 Spell Check 

CTRL + O Open F10 Key Tips (Office 2007 only) 

CTRL + P Print F12 Save As 

CTRL + R Right Align CTRL  + 

Mouse 

Wheel 

Using a scrolling wheel on your mouse, you may 

press your CTRL (Control Key) and with it pressed, 

roll your scrolling wheel up to increase the size of 

your document, worksheet, etc. and roll the wheel 

down to decrease the size. This is the keyboard 

shortcut for the zoom feature. 

CTRL + S Save 



Greg Creech 2010 Excell ing at Excel  Page 31  

www.gregcreech.com 

Greg Creech © 2011 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

There are other keyboard shortcuts, too.  You can use the help system in Excel for a list of all 

keyboard shortcuts that perform a variety of operations for you, just type Keyboard Shortcuts in 

the Help Search Box.   

Now, new to Excel 2007/2010 are keyboard shortcuts called Key Tips.  To activate your Key 

Tips, press the ALT or F10 key on your keyboard.  Excel displays screen tips or Microsoft calls 

these badges pictured here.  To activate a Tab press the corresponding badge key, for example 

press H to activate the Home Tab and 

the badges for this tabôs commands.  

Letôs try this in Excel 2010. 

1.  Open Budget workbook.  

2.  Press your Alt key to activate your Key Tips or you may press the 

Function 10 (F10) key on your keyboard to display the Key Tips.  

3.  Press your P key on your keyboard .  Notice that Excel  places you are 

the Page Layout tab and  

Key Tips on all of your 

commands on the Page 

Layout  Tab appear . 

4.  Press the O key to activate 

your Portrait or Landscape Orientation . 

5.  Press the Down Arrow key on your keyboard to Select Landscape and 

press enter to activate the selection . Your worksheet is now 

Landscape.  

6.  Letôs return this to Portrait by pressing your ALT or F10 key, Pressing P 

for Page Layout, Press O for Orientation, and since Portrait is selected, 

press enter and the worksheet returns to Portrait Orientation for you.  

 

Why Key Tips? Many people still do not like using the mouse (YET) and prefer only using the 

keyboard; using key tips you never have to use the mouse for commands in the Ribbon or 

Quick Access Toolbar.  Also, this aids people with Carpal Tunnel Syndrome.  
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The Functions Keys and combination keys such as Shift and a Function key are still around, 

too.   Here are some of the Function Keys from Excel.  

Function 
Key 

Command 

F1 Excel Help. 

F2 Edits the active cell and positions the cursor/insertion point at ǘƘŜ ŜƴŘ ƻŦ ǘƘŜ ŎŜƭƭΩǎ 

contents. 

F3 Paste Name Dialogue box appears 

F4 Repeats the last command or action. Also, if you click in your formula bar at a cell, the 

F4 key will toggle through your various references that we will learn, such as relative 

or absolute. 

F5 Go To Dialogue box activates. 

F6 Switches between the worksheet, ribbon, panes, and other areas of your worksheet. 

F7 Activates Spell Check. 

F8 Extend your selection (or increases your highlighted areas.) Press the F8 key and then 

use your arrow keys or other keys to select cells, rows, and/or columns for you. 

F9 Calculates all open worksheets. 

F10 Show Key Tips. 

F11 Creates a chart from the selected range. 

F12 Activates Save As Dialogue box. 

Activate the Help box by pressing the F1 key on your keyboard.  Type in Function keys or 

keyboard shortcuts and Excel will list a lot of shortcuts for you.  I encourage you to review these 
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and find your favorite shortcuts as you use Excel. We will use many of these shortcuts and items 

throughout our course. 

Customiz ing  the  R ibbon  ï Your  Own Tab  

and Groups 

One of the disadvantages of Office 2007was the inability to customize the ribbon and add your 

favorite and popular command buttons to your own tab as you could create toolbars and add your 

icons in Office 2003 and its predecessors.  With Office 2010 you can create your own tab and 

groups then add your favorite command buttons.  Weôll build our own tab with often used 

command buttons, now.  

1.  In Excel 2010, Right Click on a tab or 

anywhere in your ribbon and from 

the short cut menu chose Customize 

the Ribbon  (You may click the File 

Tab and go to Options for Customize 

the Ribbon, too).   

2.  Notice at the Top Right Pane 

you may choose  difference 

Tabs to view, such as Main 

Tabs, All Tabs, Tool Tabs ï 

weôll work with the Main 

Tabs.  The main tabs are 

checked and listed below 

the Customize the Ribbon box ï I have checked Developer in order to 

perform Macros and Create Excel  Forms.  

3.  Click the New Tab button, Excel  creates a 

New Tab and New Group for you.  

4.  Next, select your New Tab  and click the 

Rename button at the bottom of the pane.  

The Rename  box appears for you to enter 

the name of your Tab ï I am naming my tab ñGregôs Tabò.    After 

changing the name, click OK.  
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5.  Next select your New/Custom 

Group  and click the Rename 

button at the bottom of the 

pane.  The Rename pane 

displays change the Display 

name to Format as displayed at 

right.  Click OK af ter changing 

your name.  

6.  You can rename and change the 

picture/icon of many of your 

command buttons, too.  

 
Now, we will add commands to our 
Format Group.  

1.  Next we add buttons from the Popular Commands  pane to our tab. I 

am clicking and dragging my Format Painter from the Popular 

Commands pane to my Format Group.  Unlike the Quick Access Toolbar 

you may click and drag your items to your Group.  As with the Quick 

Access Toolbar you may click the Add button and use the Arrow keys to 

rea rrange your command 

buttons and items.  

2.  Change your Choose 

commands rom box to All 

Commands.  Excel 

alphabetically shows ALL of 

the available commands.  You 

may press the C key on your 

keyboard to jump to the Côs 

or you may use the scrolling 

button. I am ad ding the 

Conditional Formatting  

button to my Format Group on my Tab by clicking and dragging the 
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button from the left part of my screen to the right part of the pane 

illustrating my Tab and Groups.  

3.  Similar to the Quick Access Toolbar I add my Formatting commands 

such as Merge, Format Cells Font, Format Cells Number, Header & 

Footer.   

You may add buttons several ways: 

1.  With the command button you wish highlighted or selected click the Add button and 

the selected button adds underneath your selection in the right pane, 

2. Click and drag the command button from the left part of your pane to the right part of 

your pane and the Group.  

, Hot Tip! Shortcut menu and moving the Tabs.  You may 

right click on a Tab or Command Button in the 

Customize Ribbon Pane and from the shortcut menu 

perform many of the same options to avoid clicking 

buttons at the bottom or right of the  pane.  Also, you 

may rearrange  your Tabs by selec ting  the Tab and 

clicking and dragging t he tab  to its new location , you 

may use your shortcut menu as display at right  or using 

the arrow buttons to move the selected Tab, Group or 

button  up and down.  I have put my Tab (Gregôs Tab) 

first so that when I open an application this is the first 

tab that is available for me ï you may want to keep your 

Home tab as the opening Tab.   

If you right click on a Tab you may show or hide that Tab 

using the Show Tab item and checking/unchecking it. You 

may remove a tab from this shortcut men, too. , 

L An Important Gotcha! You canôt modify the buttons on the Quick Access 

Toolbar as you can using the Ribbon and your Tabs for your Command Buttons. L   
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, Hot Tip!  Modifying Buttons.  We changed the Name 

of a Group and Tab, but you may also change the 

picture of a button. You may change the Name of your 

button and the picture the command represents. 

When I added the Filter  and the AutoFilter  (two 

different commands but the same picture ), I couldnôt 

determine a difference without the Screen Tip. So, 

using my Customize Ribbon Pane I selected the 

AutoFilter  button and clicked the Rename button 

(circled at right).  Using the Rename pane displayed 

here I chose the Blue Funnel  for my picture or symbol and  I changed the 

Display name: to My Favorite Filter . Clicking OK changed my command 

buttons Name and Symbol in my pane and on my Tab.  

Also, I have added the Print Preview Full Screen  and changed the picture ï 

this is the old fashion Print Pre view. The buttons are the same for Print 

Preview and Print command button and Print Preview Full Screen  command 

button. , 

Letôs create a new Excel Tab called Data Group and add buttons. Next create a 

New Group and rename the group.  I am creating another group displayed above 

named Data  Favorites. Create and rename other groups if you wish. 

1.  Change your Choose commands rom box to All 

Commands.  Excel alphabetically shows ALL of the 

available commands.  Similar to the Quick Access Toolbar 

I add my AutoFilter , Clear Filter, Sort, Custom Sort, and 

other important and often used Excel Commands. You 

should add the buttons and groups as you use Excel and 

have your favorite commands in one place.  

2.  You may want to rename and modify your buttonôs picture, too. This is 

described in the Hot Tip above for my AutoFilter button.  After 

customizing your tab, groups, and command buttons, Click OK. You 
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have your own, productive Tab in Excel.  My Tab displays below.  

The Return o f  F i le !   

There were many improvements in Microsoftôs Office with the release of Office 

2007; however, using the Microsoft Office Button, pictured at right, instead of good, 

olô File was not one of the improvements and therefore disappears (YEAH!) with 

Office 2010. A File Tab returns bigger and better than ever. 

 

1.  With an Excel File  

open, Click the File 

tab and click the Info 

item.  

2.  My Information pane 

appears here with the 

ability to set 

permissions, share, 

and to use important 

document properties.  

Notice that the left 

part of the pan e 

contains our favorite commands of Save, Save As, Open, Close, and the 

Recently opened documents appear.   

 

Here are some of the items we will learn throughout our course in using the expanded, more 

powerful, and simpler File tab. 

V Common Commands and Simple Recent list, 

V Recent ï Pinning and unpinning, 

V Print ï One Stop Shopping, 

V Save & Send ï Saving in popular (PDF) and email at one place, 

V Options ï Setting Important Options throughout Excel. 
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Common Commands and Recen t  L is t 

When you click the File Tab, Excel should open at the Info Pane. The Info , Recent, New, Print, 

and other items ALL  contain the Save, Save As, Open, and Close items as well as Your Recent 

documents list section. My Info  Pane and File tab appear above and my Recent Pane appears 

below ï notice the Save, Save As, Recent Lists, etc. do not change. This pane is organized in 

three sections: Your Common Tasks and Commands in the right section, Important features 

and commands in the center, and then Properties to the left.  The Common Tasks and Features 

are consistent in the Office Suite.  

1.  Click the Recent item on your File Tab  (or use the button on 

your Quick Access Toolbar that we added earlier)  and at the 

bottom of the pane change the number of items (I am 

changing mine to 10) in the Quickly access this number of 

Recent Documents . The limit is 25 .  I use my Rec ent pane and pinned 

documents for items where I need a listing of more than 10.  
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, A Hot Tip!  Pinning document, workbooks, presentations, 

etc.  Across the Office Suite, except Outlook,  helps you 

quickly open your favorite and often -used files. Y ou pin your 

favorite files by clicking the push pin button at the right of 

the document or the recent pl ace.  This pins the file at the top 

of the pane. You may unpin and remove from the list by right 

clicking on the file and the shortcut menu as displayed below  

appears for you to perform popular options, including 

Opening, Pinning/Unpinning, and Removing fr om List.  You 

should pin your Recent Files and Recent Places as you begin 

opening and using your files in Office 2010.  

 

Also, notice the far right pane for Recent Places, this is new 

for Office 2010 and is terrific. I have pinned my Desktop, 

2010 Data Fil es and other directories, drives, and servers that 

I often use.  The Office Suite alphabetizes your items and 

lists, now.  Previously and like the current Quickly Access 

pane the items were sorted according the when you opened 

the file.  , 

 

We examine Print, Options and these other areas of the Return of File throughout our course.  

Now, that we are familiar with the interface, shortcuts, and other Excel items, letôs start 

Excelling at Excel with the 5 Fôs of Excel. 

 

Ï Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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The Five Fôs of Excel 

We begin our journey learning Excel through the 5 Fôs.  Here are the Five Fôs that we will learn 

in detail during this section and we will re-enforce our knowledge and build upon the 5 Fôs 

throughout our time together. 

 

F1:  Formatting 

F2:  Fills  

F3:  Formulas 

F4:  Functions 

F5:  Filters and Sorts 
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F1:   Format t ing  fo r  Appearances Sake 

Now letôs look at the 5 Fs of Excel.  The First F is Formatting.  Letôs have fun with formatting 

our cells and worksheets.  Primarily you will use the Formatting Groups on the Home Tab or 

the Format Cells Dialogue box.  

,A Hot Tip! You activate the Format Cells dialogue box by pressing your 

CTRL key and  the number 1 key at the top of your keyboard (not the 1 key on 

your key pad) simultaneously.  Also, y ou can also right click on your selected 

cells and from the shortcut menu choose Format Cells. If you added the 

Format Cells icon to your Quick Access Toolbar,  you use that too.  , 

We will learn in detail all of these command buttons on the Home Tab. We will use all of the 

tabs on the Format Cells dialogue box, too.  Before we format, we need to enter data into our 

blank worksheet.  We will enter the Text and Data as pictured below. 

1.  Open Excel, if you are not in Excel.  

2.  You should be at a blank new workbook .  If not, click the New 

Icon, if you added it to your Quick Access Toolbar or Press the 

CTRL key + N key simultaneously.   This creates a new workbook file 

for you.  Excel will display Book2 (or another number) on the title bar 

for you.  

3.  Click in Cell A2 and typ e:  January Budget and Expenses .   

To enter numeric data or alpha data simply begin typing in a cell.  As you type your input 

appears on the Formula Box Row and in the Cell in which you are typing.  Since there is no data 

in cell B2, our text will display; otherwise, our text would be truncated in Cell A2. 

To Move from Cell to Cell you may Click, Tab, or press Enter.  Depending upon your options 

pressing Tab takes you to the right one cell or Enter may take you down. To Edit previously 

Input data, Use the Formula Bar to highlight and select the data you want to change and type 

over the information or type in the cell.  
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Ï A Re-enforcement Note that your Name Box displays the cell in which you are working and 

the Formula Box displays the contents of the cell.  Move to different cells using your return 

key, tab key, arrow keys, or mouse button.  It is important to input the information first ï 

accomplish your formatting once some of your input is complete. Ï  

1.  Input as follows or enter your profession al  budget and expense data 

in the cells.  

 

 

 

 

 

 

 

2.  Save your Workbook  as My 

Budget.xlsx   (Click the Save Icon or 

use File, Save to Save your file.)  

3.  Continue inputting the information 

as pictured here.  

4.  In Cell A 14 , Type Total.  We will use 

a function  later for Excel to Total 

the information.  

5.  In Cell A 14 , Type Average.  We will 

use a function later for Excel to 

Average our information.  

,A Hot Tip!  Entering data in Excel  by 

Selecting and Using the Tab Key .   If 

you Select the area s of A5 through  C15  and using the Tab Key 

to move from cell to cell , Excel will highlight this area and 

remain in this area for input  and will not move to column D or 

row 21, until the selected range is cleared  or press an arrow 

key .  You can press the Shift key and the Tab Key  together to  

go backwards. You may press the Enter key to go down and 

the Shift and Enter Key together to  go up.  Simply select the 

Cell Data/Text 

A4 Item 

B4 Budget 

C4 Expenses 

D4 Difference 
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area for input, type your information in a cell, press the tab 

key, and Excel will move to th e next cell to the right .  This 

assists in data input accuracy .  However, you may not use the 

arrow keys or delete key; these will deselect your area or 

delete everything!  You may use the Backspace key to remove 

characters and make corrections. ,   

Formatting Groups 

Once data is in our cells and worksheet, we are ready to format.  We will format our selected 

rows, columns, and cells in several ways: 

V Formatting command buttons on the Home Tab and Font Group,  

V The Format Cells Dialogue Box, 

V Use our Quick Access Toolbar or Custom Tab, 

V The Mini Toolbar. 

 

, A Hot Tip: The Mini Toolbar .  When you right click 

selected cells, rows, or columns, Excel provides a Mini 

Toolbar containing many popular commands, including 

formatting commands, such as font, font size, dollars, bold, 

colors, and so on.  The menu toolbar is at the bottom  of the 

short cut menu. We will use this a lot in this course.  Excel 

provides a short cut menu when you right click, too. You 

may activate th e Format Cells Dialogue Box from this 

menu.  , 

The Merge and Center 

Okay, Letô have fun with formatting; we first want to have our title January Budget and 

Expenses centered across our worksheet area. In using Excel the text and information for a cell 

will display unless there is text and data in the adjacent cell, then your data is truncated or cut-

off.  The text and data are still there just not visible except on the Formula Bar. You have three 

choices 

V To make the column wider so your information will fit, 
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V To use Wrap text in the cell (which we will learn later), 

V To use the Merge and Center Icon. 

In most cases make the column wider is acceptable; however, your column heading may be too 

wide for the data in the rest of the column.  ,A Hot Tip!  For Headings and Titles You will 

want to use the Merge and Center Command Button.  The Merge and Center 

command button above will collapse your selected cells into one cell and center 

the information in this one cell. 

1.  Using the Click and Drag method of selection, S elect the 

cells A2 through D2.  

2. Once selected, Click the Merge and Center command button or use your 

Mini Toolbar . 

Our A2 cell is now one, big cell encompassing the former cells of B2 through D2.  Click Cell D2, 

notice the Name Box displays A2.  The Merge and Center Command button: This icon is 

primarily used for titles that extend beyond one cell. 

Ï As a review, select the cells you want merged and click this icon to transform multiple cells 

into one cell and center the information contained in the cell. 

LAn Important Gotcha!  If you try to sort your data do NOT 

include this cell.  Excel will  give you an error message as 

displayed at right. To remove Merge and Center from a Cell, 

Select the cell and click the Merge and Center command button, 

again. Or you may remove Merge and Center by using the 

Format Cells Dialogue Box and the Alignment Tab.  At the Dialogue box click the 

Alignment tab and notice the check mark in the Merge cells box, Uncheck (click the check 

mark) box in Merge cells.  The cells option will be removed.  L 

Font Group 

With Cell A2 the Merge and Centered cell selected and using the Font Groupôs command 

buttons please make the following changes: 

1.  Change the Font to Arial  using the font drop 

down list ,  

2.  Change the size to 14  using the list ,  












































































































































































































































































































































































































































































